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Shape-Out 2

Shape-Out 2 is the successor of Shape-Out, a user interface for data analysis in real-time deformability cytometry
(RT-DC). This is the documentation of Shape-Out version 2.2.4.

This documentation is also available as a PDF.
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CHAPTER 1

Getting started

1.1 Installation

Shape-Out 2 can be installed via multiple channels.

1. Windows installer: Download the latest version for your architecture (i.e. Shape-Out_X.Y.
Z_win_64bit_setup.exe) from the official release page.

2. macOS: Download the latest version (Shape-Out_X.Y.Z.dmg or Shape-Out_X.Y.Z.pkqg) from the
official release page.

3. Python 3.6 with pip: Shape-Out can easily be installed with pip:

’pip install shapeout2

To start Shape-Out, simply run python -m shapeout2 or shapeout?2 in a command shell.

1.2 Update

Shape-Out automatically searches for updates (you may opt-out via the Help menu) and notifies the user when a new
version is available.

1. Windows installer: The older version of Shape-Out will be automatically uninstalled when installing a new
version.

2. macOS: The older version of Shape-Out will be automatically uninstalled when installing a new version.

3. Python 3.6 and pip:

pip install —--upgrade shapeout?2



https://github.com/ZELLMECHANIK-DRESDEN/ShapeOut2/releases/latest
https://github.com/ZELLMECHANIK-DRESDEN/ShapeOut2/releases/latest
https://pip.pypa.io/en/stable/quickstart/
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CHAPTER 2

RT-DC Basics

This section conveys the basic understanding necessary for analyzing and interpreting RT-DC data. If you have the
feeling that something is not covered here, please create an issue on GitHub.

2.1 Working Principle

In Real-time deformability cytometry (RT-DC), small objects, such as cells or beads, are flushed through a narrow
channel at high speeds. The flow profile inside the channel causes hydrodynamic stresses that deform these objects
[MOG+15], [MMM+17]. For each event (detected object), an image is recorded and analyzed in real-time [ORM+15].
The analysis consists of the extraction of several features from the event images, such as deformation, projected area,
or average brightness. These features can then be used to identify and characterize sample populations; For instance,
major blood cells and their pathological changes in disease conditions [THO+17].

2.2 Measured Features

A multitude of features can be extracted from the data recorded during an RT-DC measurement. These features are
mostly computed live during data acquisition and are stored alongside the raw image data. Here, only the most impor-
tant features are discussed. A full list of the features available in Shape-Out is maintained in the dclab documentation.

2.2.1 Area and porosity

The area is the projected object area which is determined via the contour of the binarized event image. Shape-Out
differentiates between two types of area, area of the measured contour (“Measured area [px]”) and area of the convex
contour (“Convex area [px]” and “Area [pmz]”). The convex contour is the convex hull of the measured contour and
enables a quantification of porosity (convex to measured area ratio). The porosity is often used for filtering, e.g. to
remove high-porosity dirt particles in a preprocessing step.

! Detection Of Human Disease Conditions By Single-Cell Morpho-Rheological Phenotyping Of Whole Blood by Toepfner et al., licensed under
CCBY 4.0 [THO+17].



https://github.com/ZELLMECHANIK-DRESDEN/ShapeOut2/issues/new
https://dclab.readthedocs.io/en/stable/sec_av_notation.html#sec-features
https://en.wikipedia.org/wiki/Convex_hull
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Fig. 2.1: Single-cell, morpho-rheological phenotyping of blood. (A) Analysis of whole, diluted blood. Hydrodynamic
shear forces (red arrows) induce deformation of cells passing through a microfluidic channel (20x20 um?) at speeds of
more than 30 cm/s (blue arrows). (B) Representative images of blood cell types acquired. Scale bar is 10 um. Figure
and caption adapted from Toepfner et al.'.
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Fig. 2.2: Visualization of porosity. (A) The measured contour (blue line) defines the measured area (blue shade). The
convex contour (red line) results in an area (red shade) that is usually larger than the measured area. (B) The porosity
is the ratio between measured and convex contour. The difference (the “pores’) between the measured and convex
areas is indicated in green. Porosity is often used to remove events with non-physical contours, e.g. for cells all events
with a porosity above 1.05.
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A porosity of 1 means that the measured contour is convex. Note that the porosity can only assume values larger than
1. Also note that the convex contour/area is computed on the same pixel grid as the measured contour/area and is, as
such, subject to pixelation artifacts.

2.2.2 Bounding box

The bounding box of an event image is the smallest rectangle (with its sides parallel to the x and y axes) that can hold
the event contour. The aspect ratio of the bounding box is the rectangle’s side length along x divided by the side length
along y. The size of the bounding box along x and y as well as its aspect ratio are often used for filtering.

detected cell min aspect max aspect
within the min length : .
bounding box & height max length Ratio 0.14 Ratic 6.5
|
E
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H S Y= ——
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1=}

=

Fig. 2.3: Illustration of the event bounding box and its use cases. From left to right: definition of the bounding box,
exclusion of small objects (e.g. debris) via the bounding box size, exclusion of clusters via the bounding box size,
exclusion of objects elongated perpendicular to the channel axis, exclusion of objects elongated along the channel
axis.

2.2.3 Brightness within contour

Quantifying the brightness values within the image contour yields information on object properties such as homogene-
ity or density. For instance, it has been shown that the quantities “mean brightness” and “convex area” are sufficient
to identify (and count) all major blood cells in a drop of blood [THO+17].

In addition to the average brightness values, Shape-Out also has access to the standard deviation of the brightness in
each image.

2.2.4 Deformation and elasticity

The deformation describes how much an event image deviates from a circular shape. It is defined via the circularity:

deformation = 1 — circularity

=1-2V7A/l

with the projected area A and the contour length of the convex hull of the event image [. The contour length is com-
puted from the convex hull to prevent an overestimation due to irregular, non-convex event shapes. It has been shown
that the knowledge of deformation and area allows to derive a value for elasticity in RT-DC [MOG+15] [MMM+17].
As a convenient measure for elasticity, isoelasticity lines are often employed to visualize stiffness.

Note that it is also possible to directly access the Young’s modulus in Shape-QOut.

2.2. Measured Features 7
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Fig. 2.4: Blood-classification with event brightness and cell size. (A) Representative images of blood cell types
acquired. Scale bar is 10 um. (B) Brightness versus cell size (area) scatter plot with cell types labeled according to the
color scheme in (A). Figure and caption adapted from Toepfner et al.!.
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Fig. 2.5: (A) Typical deformation versus cell size scatter plot. The color scale indicates event density. (B) Isoelasticity
lines derived from numerical simulations indicate trends in stiffness.
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2.2.5 Fluorescence

Real-time fluorescence and deformability cytometry (RT-FDC) records, in addition to the event images, the fluores-
cence signal of each event [RPJ+18]. The raw fluorescence data consists of the one-dimensional fluorescence intensity
trace from which features such as peak fluorescence or peak width can be computed. For more advanced applications,
RT-FDC also supports multiple fluorescence channels.
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Fig. 2.6: (A) Event brightfield image. (B) Fluorescence trace of the event. The raw fluorescence data and the fluores-
cence data filtered with a rolling median filter (from which the parameters are computed) is shown. (C) Scatter plot of
two parameters extracted from the fluorescence trace.

2.2.6 Inertia ratio

The inertia ratio is the ratio of the second order central moments along x and y computed for the event contour. Thus,
the inertia ratio is a measure of deformation. In comparison to deformation, the inertia ratio has a low correlation to
porosity. Shape-Out also allows to compute the principal inertia ratio which is the maximal inertia ratio that can be
obtained by rotating the contour. Thus, the principal inertia ratio is rotation-invariant which makes it applicable to
reservoir measurements where e.g. cells are not aligned with the channel. To quantify the alignment of the measured
objects with the measurement channel, Shape-Out can additionally quantify the tilt of the contour relative to the
channel axis.

2.2.7 Volume

Shape-Out can compute the volume from the event contour under the assumption of rotational symmetry, i.e. it is
assumed that the projection of the cell volume onto the detector plane does not change when the cell is rotated, with
a rotational axis parallel to the flow direction. The computation of the volume is based on a full rotation of the upper
and the lower halves of the contour from which the average is then used [HWTO02]. Volume has the advantage to be
less correlated to deformation when compared to the projected area and it is therefore a better measure of cell size in
the channel.

2.2. Measured Features 9
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Fig. 2.7: (A) For a rectangle that is aligned with the coordinate axes, the inertia ratio and the principal inertia ratio
are identical. (B) If the rectangle is rotated, the inertia ratio changes, but the principal inertia ratio does not. (C)
Comparison between deformation and inertia ratio when plotted against porosity for an exemplary RT-DC experiment.
Deformation exhibits a higher correlation to porisity.
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Fig. 2.8: (A) Deformation versus area (red) and volume (cyan) for an exemplary RT-DC dataset. There is a correla-
tion between area and deformation, at least for small (<50pm2) areas. (B) Inertia ratio versus area and volume. A
correlation between inertia ratio and area is visible as well.
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CHAPTER 3

User Interface

3.1 Differences to Shape-Out 1

Shape-Out 2 is a complete rewrite of the user interface from scratch. The overall user experience is much better
compared to Shape-Out 1. The main reasons for the development of Shape-Out 2 were:

* The graphical user interface (GUI) of Shape-Out 1 was designed to be flexible with regard to new configuration
parameters. While this played well for the beginning of RT-DC development, the GUI now appears not very
thought-out for a mature measuring technique. The workflow of Shape-Out 2 has been designed to meet most
of its users needs.

* Shape-Out 1 is condemned to Python 2 (which reached its end of life January 1st 2020), because it relies on the
combination of chaco (for plotting) with wxPython 3 (for the GUI). Chaco is now focusing on PyQt and thus
does not support the new wxPython 4. However, wxPython 3 does not support Python 3, so we are stuck with
Python 2.

* For Shape-Out 1, there appeared a weird issue which is probably related to the old wxPython library and some
other software installed on some Windows systems.

Both versions of Shape-Out rely on dclab which provides the core functionalities for RT-DC data analysis. There
are, however, a few breaking changes that might prevent you from moving your data analysis from Shape-Out 1 to
Shape-Out 2:

 Shape-Out 2 does not anymore support the .tdms file format. If you would like to use .tdms data in Shape-Out
2, you have to convert those data to the .rtdc file format first. You can do just that with DCKit, which provides a
convenient GUI for several other RT-DC data management tasks as well. The .rtdc file format is faster, occupies
less space on disk, and consists of only one file per measurement (no more para.ini, etc.).

 Shape-Out 1 sessions cannot be opened in Shape-Out 2. This is mostly caused by the different approach to data
analysis. In principle, it could be possible to convert sessions (including the corresponding .tdms files), but the
effort in doing so would probably exceed the effort required to just rebuild a clean analysis session in Shape-Out
2.

 Shape-Out 2 does not provide a linear mixed effects models (LMM) analysis. LMM analysis in Shape-Out
1 is done using R/lme4 and thus requires a full R distribution shipped with Shape-Out 1. This blows up the
installation size and makes it more difficult to deploy. Furthermore (and we are not saying that LMM Analysis

11
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is “bad”) we are also looking into other methods for determining statistical significance which might be more
intuitive to understand.

3.2 Terminology

Shape-Out 2 introduces several terms in the user interface that also play a role in data analysis and are consequently
used in the entire code base.

block matrix The Block Matrix is a visualization of the analysis pipeline. It is divided into data matrix (filters) and
plot matrix (plots).

dataslot or slot A slot holds all information about a measurement: the path to the .rtdc file, fluorescence labels,
display color, etc. (see the Dataset tab in the Analysis View).

filter A filter is a set of filtering options (box filter, polygon filter, downsampling, etc.) that can be applied to a slot
(see the Filter tab in the Analysis View). Filters can be exported and imported again in Shape-Out 2 (.sof file
format).

filter ray A filter ray is a list of filters that can be applied to a slot. In Shape-Out 2, each row in the Block Matrix
contains one filter ray.

pipeline A pipeline consists of all filters, slots, plots, and the filter rays (the filter selection) applied to each slot. A
Shape-Out 2 session file (.s02) stores all information necessary to rebuild a pipeline.

plot A plot is a user-defined visualization of a slot/filter ray combination.

3.3 Basic usage

The user interface is split into several parts: the menu bar and the tool bar at the top, the Block Matrix on the left, and
the Workspace on the right (example data taken from [NUH+19a], [NUH+19b]).

3.3.1 Menu bar and tool bar

The menu bar is used for session management (File menu) and makes additional functionalities available, such as data
statistics, data export, plot export, or filter import/export. The tool bar contains shortcuts for adding new datasets,
filters, or plots (left part) and allows to hide/show the Block Matrix as well as the Quick View and Analysis View
windows (right part).

12 Chapter 3. User Interface
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3.3.2 Block Matrix

Preproce... | %/ | brightne... surface... sortinge.. 4
Block i edit #edit  Fedit ¥ edit
Matrix

VI =, o0 === 000 =, [ e
blood initial
= 0.04

¥ edit active active active active

VE e

blood tar...
= 0.04

active
# edit Qv)

iR=| s

&

active active active

The Block Matrix gives an overview of the current analysis pipeline. Each row represents a dataset (purple). The
columns represent either filters (yellow) or plots (blue) of your pipeline.

You can perform dataset operations in the purple rectangular area at the beginning of each row: To modify a dataset,
click on the edit button. You can duplicate, insert anew (unmodified), or remove datasets using the dropdown menu.
You can also exclude a dataset from an analysis via the check box.

Filters can also be modified, copied, removed and disabled. By default, all filters are disabled when they are created.
To apply a filter to a dataset, click on the corresponding matrix element. The element changes its color from gray
(incactive) to green (active). In Shape-Out, all filters that are applied to a dataset are called a filter ray. In the above
example, the filter ray only consists of a single filter for each dataset. Filter rays may be different for each dataset.

By holding down the Shift key while clicking on a matrix element, you can activate the Quick View for the specific
dataset (with filters applied up until the selected column). The block matrix element is then colored pink.

To add a plot, click on the New Plot button in the tool bar. This adds a plot column with a blue header to the Block
Matrix and creates an empty plot window. You can add datasets to your plot by clicking on the corresponding matrix
elements. In the above example, both datasets are being used in all three plots.

The modification of datasets, filters, and plots is discussed below.

3.3.3 Workspace

The Workspace is designed as an infinite scrollable area and contains all plot windows as well as the Quick View and
Analysis View windows.

3.3.4 Analysis View

The analysis view is separated into four tabs (see screenshots below).
* The Meta tab displays all metadata of the selected dataset that are stored in the original .rtdc file.

* The Dataset tab allows to specify additional metadata, such as unique colors used for plotting and additional
metadata for computing the Young’s modulus or correcting for fluorescence cross-talk. It also allows to specify
fluorescence channel labels that will then be used for labeling the axes of plots.

» The Filter tab is used to modify the filters of the pipeline. New box filters can be added by selecting Choose
box filters. . . . Polygon filters are created in the Quick View window.

* The Plot tab allows to specify all plotting parameters. Please take special note of the Division option in the
Layout section (defines the arrangement of the subplots) and the Marker hue option in the Scatter plot section

3.3. Basic usage 13
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(allows you the specify whether the scatter data points are colored according to a kernel density estimate (KDE),
another feature dimension, or the dataset color specified in the Dataset tab). In this example, contour plots are
not used.

@ Meta | @ Dataset W Filter 4 Plot

Dataset |blood target ~

Experiment

Sample name: Figure3 Blood Target_neuBr
Index of measurement run: 1

Mumber of recorded events: 8785

Date of measurement: 2019-05-27

Start time of measurement: 12:07:10

Setup

Medium used: CellCarrier B

Width of microfluidic channel: 20.00 pm

Imaged chip region: channel

Flow rate in channel: 0.0400 pL/s

sample Flow rate: 0.0100 pL/s

Sheath flow rate: 0.0300 pL/s

Unique setup identifier: ZMDD-AcC-fe3cdd-2a2250
Modules used: AcCellerator, FluorescenceModule
Software: Shapeln 2.0.8

Imaging

Light source device type: LED (ZMD L1)
Light source flash duration: 2.00 ps
Imaging frame rate: 1250.00 Hz

Pixel size: 0.340 pm

Image x coordinate on sensor: 629.00 px
Image y coordinate on sensor: 512.00 px
Image width: 250 px

Image height: 80 px

Fluorescence

Trace bit depth: 16

FL1 description: 525/50

FL2 description: 593/46

FL3 description: 700/75
MNumber of active channels: 3

Numhber af availahla channele: 2
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Name brightness-based sorting

Layout
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3.3.5 Quick View

The Quick View is meant for dataset exploration. It consists of a scatter plot on the left (left click for panning and
right-click for zooming) and a set of tool panels that are accessible via the corresponding tool buttons on the right.

Use the Plot panel to define all plot parameters. It also displays common statistics of the two features plotted.

3.3. Basic usage 17
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The Event panel displays all parameters of an individual event. You can select single events by clicking in the scatter
plot or by scrolling through the Index spin control. If available, the event image is shown alongside the fluorescence
trace of the event. All features of the event are listed in a separate tab.
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The Polygon Filter panel allows you to create and modify polygon filters. When the panel is active you can move the

mouse pointer across the scatter plot and the image of the event closest to the mouse pointer is displayed.
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CHAPTER 4

Quick Guides

4.1 Checking experimental data for consistency

¢ Trends over time:

To verify that the sample “behaves” stationary during the measurement, it is helpful to plot a few selected
features versus time. No systematic deviations should be observable, as in the figure below.

0.5 -
800 A
0.4 -
| = ’
o
© 0.3 1 s
£
.E
()]
[m]
S : ';"L .h ‘
m

0 100 200 300 400 500 0 100 200 300 400 500
Event time [s] Event time [s]

Fig. 4.1: Deformation and event area versus time. There is no systematic trend over time, indicating stable measure-
ment conditions.

¢ Countrate:

Trends over time do not directly visualize the count rate (measured events per second). The count rate is the
slope of the event index versus event time plot and should remain constant.
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Fig. 4.2: The event index versus event time plot shows a constant slope, an indicator for stable measurement conditions.

4.2 Excluding invalid events

Filters can be used to exclude invalid events, such as cell debris, cell doublets or larger aggregates, or cells that are not
intact, from an analysis.

¢ Area:

The event area (the area defined by the event contour) can be used to filter cell aggregates (larger area), dead or
degenerate cells, as well as cell debris (small area). Use the deformation versus area plot to identify exclusion
candidates by clicking on an event and visualizing it in the event area.

reference debris

Area [pm?]: 163 g e AFOR M2,

aggregate

Area [pm?]: 584

Fig. 4.3: Examples of events with small or large areas.

* Aspect and inertia ratio:

The aspect ratio of the bounding box and the inertia ratio of the contour can be used to filter cell aggregates and
otherwise invalid events. For instance, an aspect ratio below 1 (elongation perpendicular to the channel axis) is
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most-likely debris and can be excluded from the analysis. An inertia ratio below 1 also indicates invalid events.

reference small inertia ratio

Fig. 4.4: Examples of events with various aspect and inertia ratios.

* Porosity:

The porosity is the ratio between measured contour and the convex contour. Porosity is commonly used to
remove events with non-physical contours, e.g. for cells, all events with a porosity above 1.05.

reference extremely porous

Fig. 4.5: Examples of events with various porosities.

4.3 Accessing DCOR data

The deformability cytometry open repository (DCOR) allows you to upload and access RT-DC datasets online (internet
connection required). In Shape-Out 2, you can access parts of the dataset (e.g. just two features) without downloading
the entire data file (which includes image, contour, and traces information). This saves disk space and time when
accessing large datasets.

4.3. Accessing DCOR data 23
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Access settings

Server |dcor.mplmpg.de -

APl Key |optional (to access private data)

Free text ~ | sorting Search

Sorting real-time fluorescence and deformability cytometry (soRT-FDC) - manuscript data: =
Sorting real-time Fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
sorting real-time fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
sorting real-time fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
sorting real-time fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
sorting real-time fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
Sorting real-time Fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
sorting real-time fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
sorting real-time fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
sorting real-time fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
Sorting real-time Fluorescence and deformability cytometry (soRT-FDC) - manuscript data:
sorting real-time fluorescence and deformability cytometry (soRT-FDC) - manuscript data:

i s

L] ¥

e

& Cancel | B2 Open

Fig. 4.6: Dialog for loading DCOR data.

In the File menu, choose Load DCOR data. A dialog (Fig. 4.6) lets you search data in the DCOR repository.

Note: If you need to access private data, you have to enter your personal API Key. You can find your personal API
Key in your user pofile page after logging in at https://dcor.mpl.mpg.de.

You can choose between a free text search (dataset and resource names, tags, etc.) and an identifier search (dataset
and resource identifiers). After clicking the Search button, you may select the resources you wish to load into your
sesssion in the list view below. Then, click Open to load the data.

4.4 Young’s Modulus

With Shape-Out, it is possible to translate the measured area and deformation to the Young’s modulus based on
numerical simulation for fully elastic spheres according to Mokbel et al. [MMM+17].

Note: For reservoir data, the Young’s modulus cannot be computed and the corresponding options are hidden.
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4.4.1 Usage

Young's modulus

Medium CellCarrier -

Temperature From metadata ~ | 22.5°C

Viscosity 6.02 Pa-s

Fig. 4.7: Temperature taken from the meta data.

The parameters for computing the Young’s mod-
ulus can be set in the Dataset tab of the Analy-
sis View. The Young’s modulus is computed us-
ing a precomputed look-up table and additionally
depends on channel width, flow rate, pixel size
(pixelation correction), and viscosity. For known
media, such as CellCarrier, the viscosity can be
derived from channel width, flow rate, and tem-
perature. In some RT-DC setups, the chip temper-
ature is recorded during the measurement. For
instance, in Fig. 4.7, the average chip tempera-
ture of 22.5°C from the [setup] meta data sec-
tion is used. The value of the resulting viscos-

Medium

Viscosity

Young's modulus

CellCarrier v

Temperature From feature -

Fig. 4.8: Use the temperature (temp) feature.

ity is shown below. If the chip temperature is recorded for each event, then the user may select the From feature
option (Fig. 4.8). In this case, the Young’s modulus is computed from the individual viscosities for each event.

If the temperature is not given as a feature or as meta
data, then you may select the temperature manually. This
case is visualized in Fig. 4.9. Here, the temperature
is purposely set outside of the known range defined in
[Her17], which is highlighted by coloring the viscosity red.

You may also set the viscosity manually by selecting other as a
medium (Fig. ??). In this case, the values for temperature are ir-
relevant. Please only use this option if you know what you are
doing (e.g. you have considered shear-thinning [Her17]).

Click Apply for any changes to take effect. The Young’s modulus
is then available for the selected dataset.

4.4.2 Validity

The computation of the Young’s modulus is valid
only for objects that initially have a spherical
shape. In addition, the deformation and size val-
ues must be in a “valid region”. Events outside
this region will have a nan-valued (not a num-
ber) Young’s modulus. Note that as a result, these
events will be excluded from all plots when re-
move invalid events is checked in the Filter con-
figuration tab.

Young's modulus

Medium Cellcarrier -
Temperature | Manual * | 31.0°C|>
Viscosity 4.56 Pa-s

Fig. 4.9: Temperature outside of known range.

4.4. Young’s Modulus
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Fig. 4.11: Visualizations of the support and the values of the look-up table (LUT) used for determining the Young’s
modulus from deformation and cell area. The values of the Young’s moduli in the regions shown depend on the channel
size, the flow rate, the temperature, and the viscosity of the medium [MOG+15]. Here, they are computed for a 20 um
wide channel at 23°C with an effective pixel size of 0.34 pym. The data are corrected for pixelation effects according
to [Herl7].
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The invalid regions (white in the figure above) in-

clude objects that are very small or objects with

very low deformation values. The reason for that

is a very steep increase of the Young’s modu-

lus with little decrease in deformation that could

potentially result in very large simulation errors.

In addition, regions with high deformation are

invalid as well, because the simulations do not

converge (objects simulated with lower Young’s

moduli become more and more elongated until

they rupture). In practice, this means that the

channel size has to be selected carefully to match the object sizes. Larger object sizes require wider channels if
meaningful values for the Young’s modulus are to be computed.

In the following, additional visualizations for
other commonly used channel sizes and flow
rates are shown:
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4.4.3 Implementation

As described above, the Young’s modulus can be
derived in multiple ways, for known media and
global or event-based temperature values. The
underlying implementation is described in the
dclab docs.

4.5 Compute statistics

The Quick View window quantifies the statis-
tics for the features shown there. If you
need access to statistics for more features of a
dataset or if you need to quantify the statistics
for multiple datasets on disk, you can use the
Statistics tool available via the Compute menu.

There are two modes of operation.
The first mode exports statistical data
from the current session (Fig. 4.12).  Compute statistics for multiple datasets.
Statistics are always computed af-
ter the filter ray has been applied.
You may select the features in the

All datasets of the current session w

table on the left and the desired Absolute ztllt of raw cg v Events
statistics in the table on the right. v/ Area [pm?] v Flow rate
Aspectratio of bound | | ¥ Mean

The second mode computes statistics Bounding box size x [} v Median

lect the All datasets in a directory op- Brightness sD within ¢ v SD

tion and (optionally) a filter ray from the Brightness average wi

current session that you would like to Circularity

apply before computing the statistics. Convex area [px]

Note that statistics may not be available Deformation

for all selected features in all datasets. Event index (Dataset) _

In such a case, statistics are exported as I —_ = '

nan values in the resulting .tsv file. S—

& Cancel < OK

Compute statistics for multiple datasets.
All datasets in a directory -
/some/other/path/to/dats T Fig. 4.12: Statistics export of current session

Filter ray | Ray O (Figure3_Blood_lInitial) -

Absolute tilt of raw cc* | v| Events
Ambient temperature || Flow rate

v| Area [pm?] v| Mean
Aspect ratio of bound ¥ Median
Bounding box size x [} | v/ Mode
Bounding box sizey [} | v/ SD
Brightness SD within ¢

Rrinhtnecs auarane wi™
b

& cancel v OK

Fig. 4.13: Compute statistics for other
data
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CHAPTER B

Changelog

List of changes in-between Shape-Out releases.

5.1 version 2.2.4

« fix: Ul slot issues (probably a racing condition) in the analysis view; editing the viscosity for “other” medium
not possible on frozen Windows and macOS application (#49)

5.2 version 2.2.3

* fix: update Quick View plot when values for the Young’s modulus computation are changed (#44)
* fix: use fixed point size in Block Matrix

* enh: improve plot matrix column/row visualization and show flow rate (#45)

¢ docs: update visualization of Young’s modulus look-up tables using new figure script from dclab
¢ build: bump Python to 3.8 for Windows builds

* setup: bump dclab from 0.27.5 to 0.27.11 (improvement of hierarchy child handling)

5.3 version 2.2.2

* fix: correct box filter ranges when feature contains inf values

¢ enh: add pretty tool icons from KDE breeze theme
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5.4

5.5

version 2.2.1

fix: zero-division error when setting “one plot per dataset” for an empty plot (#41)

build: pin PyQt5 to 5.14.2 on Linux/macOS

version 2.2.0

setup: bump dclab from 0.26.2 to 0.27.5 (support for machine learning features)
fix: modify the GUI to enable box filtering for ml_score_??7? features

ref: pipeline.get_features now only returns features that are available (previously all features were returned when
no datasets were in the pipeline)

version 2.1.6

fix: export file names were allowed to have invalid characters
fix: Quick View showed filtered events that were not plotted (statistics were computed correctly though)
fix: Quick View was not very informative when all events were filtered away - a message is now shown

setup: bump dclab from 0.26.1 to 0.26.2 (fix bin num computation using Doane’s formula)

version 2.1.5

fix: marker hue feature data min/max was always computed even if not selected; for datasets without bright_avg
(standard hue) this resulted in long waiting times

fix: avoid pyqtgraph error messages in pipeline plots by disabling hovering events (not used anyway)
fix: plot export did not work for single plots

fix: exported event images sometimes had wrong contrast

version 2.1.4

enh: add busy cursors wherever it seems fitting

setup: bump dclab from 0.24.7 to 0.26.1 (volume-deformation isoelasticity lines, improved DCOR caching)

version 2.1.3

fix: opening sessions did not work due to missing slot decorator

fix: in some cases the temperature/viscosity setting was not correctly written to the Ul for individual slots when
switching between slots with fundamentally different settings (e.g. channel and reservoir)

fix: KeyError when switching between slots with different temperature options
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e setup: bump dclab from 0.23.0 to 0.24.7 (equidistant isoelastics, faster polygon filtering, crosstalk correction

failed due to improper configuration update since Shape-Out 2.1.1)

5.10 version 2.1.2

fix: ValueError when trying to compute contour spacing, because no datasets are selected for a plot
fix: coloring scatter plot by feature did not work when the feature contains nan values
fix: search path in session should not be filename but its directory

setup: bump dclab from 0.22.5 to 0.23.0 (possible HDF5 export issue)

5.11 version 2.1.1

fix: include private datasets when searching with DCOR API Key

fix: remove UI option to compute Young’s modulus for reservoir data (new “emodulus enabled” key in pipeline
slot)

fix: Pipeline object not returned by session.open_session

setup: bump dclab from 0.22.1 to 0.22.5 (improve contour retrieval for mask images with artefacts, disable
computation of Young’s modulus for reservoir measurements)

5.12 version 2.1.0

feat: basic DCOR support

fix: improved session support (older pre-release sessions)
docs: add DCOR guick guide

enh: export event image via context menu in Quick View (#35)

setup: bump dclab from 0.21.1 to 0.22.1 (DCOR support)

5.13 version 2.0.3

setup: bump dclab from 0.20.3 to 0.21.1

docs: add terminology section (#12)

5.14 version 2.0.2

fix: IndexError when removing a plot (#36)
fix: ValueError when filtering all events in Quick View (#37)
fix: TypeError when removing datasets and opening Quick View (#38)

fix: RuntimeError when removing datasets and opening Quick View (#38)

5.10.
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* fix: ValueError when removing activated datasets and opening Quick View

5.15 version 2.0.1

* fix: correctly distinguish prereleases when checking for new versions

* enh: allow loading data via drag&drop

5.16 version 2.0.0

e initial release
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CHAPTER /

Imprint/Impressum

7.1 Imprint and disclaimer

For more information, please refer to the imprint and disclaimer (Impressum und Haftungsausschluss) at https:/www.
zellmechanik.com/Imprint.html.

7.2 Privacy policy

This documentation is hosted on https://readthedocs.org/ whose privacy policy applies.
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CHAPTER 8

Indices and tables

* genindex
* modindex

e search
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